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1. Introduction

The development of the Non-Vehicular Diesel Engine Risk Assessment Guidance (Guidance) included
a tool created to assist local Air Pollution Control Districts and Air Quality Management Districts
(Districts) in performing screening health risk assessments (HRAs) of toxic emissions from diesel
internal combustion engines (DICE). The Hotspots Analysis and Reporting Program 2 (HARP2) Diesel
Internal Combustion Engine Risk Assessment Tool (DICE Risk Tool) follows this Guidance and allows
users to perform customized screening health risk assessments (HRAs). Users of the DICE Risk Tool
should refer to the Guidance for a complete technical understanding of the inputs to the tool, as well
as its limitations.

2. Downloading the DICE Risk Tool

This section provides information for installing the program.
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2.2

System Requirements

Before installing the DICE Risk Tool on your computer, please review the system requirements.
The current version of the DICE Risk Tool is a Microsoft Windows based program and can be
installed on any Windows operating system that supports the Microsoft .NET Framework 4.0
or later. Additional system requirements include:

e 2 GBof RAM
e 20 MB of free hard drive space for the DICE Risk Tool program files
e At least 1 GB of storage space for project files

Installing the DICE Risk Tool

The DICE Risk Tool installation files are available on the Internet at:

https://ww2.arb.ca.gov/resources/documents/non-vehicular-diesel-engine-risk-assessment-
guidance

Click the Download Software and User Guide link. Follow the online instructions for complete
details on how to download the installation software. Once the installation setup file has been
downloaded and saved to your hard drive, double-click on it to begin the program setup.
Follow the on-screen instructions to complete the setup.

The default destination folder is C:\DICE. It is recommended that you install to the default
destination folder. In addition, the installer will create a DICE Risk Tool folder on your desktop.
This folder will contain shortcuts to the program’s executable file and the user guide.


https://ww2.arb.ca.gov/sites/default/files/classic/ab2588/2024%20DICE%20Screening%20Risk%20Guidelines.pdf
https://ww2.arb.ca.gov/resources/documents/non-vehicular-diesel-engine-risk-assessment-guidance
https://ww2.arb.ca.gov/resources/documents/non-vehicular-diesel-engine-risk-assessment-guidance

2.3 Opening the Program

To launch the DICE Risk Tool, open the DICE folder found on your desktop. Double-click on the
DICE icon.

%@

2.4 Getting Familiar with the Program

The DICE Risk Tool is designed as a wizard to guide the user through the emissions calculation,
air dispersion modeling and risk assessment process. It has been streamlined to require
minimal user input, while still providing a robust assessment. The DICE Risk Tool is composed
of the following main user screens:

Title

Project Information
Engine Information
Building Information
Receptor Information
Run and View Results

The sections that follow provide a step by step description of the use of the DICE Risk Tool.

3. Calculating Risk

3.1 Required Information for Performing an Assessment

The DICE Risk Tool uses the following information to perform a health risk assessment:

Engine exhaust stack parameters: stack height, stack diameter, exhaust temperature
and exhaust exit velocity or flow rate. If not known, the DICE Risk Tool provides defaults
based on engine horsepower.

Engine exhaust release type: vertical, horizontal or capped.

Annual diesel PM1o emissions (Ibs/year). If not known, the DICE Risk Tool will calculate
emissions given engine horsepower, engine load, diesel PM1o emission factor (g/bhp-hr
or g/kw-hr), and engine annual activity in hours or gallons.

Building information (if applicable).

Nearest resident and worker receptor distance (m).

AERMOD ready meteorological data. A link is provided to data for California.

Name of Agency with jurisdiction over the project (in order to select the appropriate
pre-set default risk settings) or user-entered risk settings.



3.2 Opening the DICE Risk Tool

Launching the DICE Risk Tool will open the title screen as shown in Figure 1. On this screen,
the user can start a new project by selecting the Next button on the bottom right, or open a
previously saved project by selecting the Open Project option in the File drop-down menu.
The GoTo drop-down menu allows the user to navigate to a specific screen in the DICE Risk
Tool.

Figure 1 - DICE Risk Tool on Startup

File GoTo
For DICE questions, please visit
Developed by
CALIFORNIA
AIR RESOURCES BOARD
Convert

A conversion tool, shown in Figure 2, is available to the user from most screens by selecting
the Convert button located in the bottom left corner of the DICE Risk Tool.

The conversion tool allows the user to convert common units for the following measurements:

e Length — Feet, inches, and miles to meters.

e Temperature — Fahrenheit and Celsius to Kelvin.

e Velocity — Feet per second and kilometers per hour to meters per second.

e Flow Rate — Cubic Feet per second, minute, and hour to cubic meters per second.

To use the conversion tool, enter the desired numerical value in the white boxes under Convert
From. The conversion tool will then automatically generate the converted value into the
corresponding grey boxes located under Convert To as shown in Figure 3.



Figure 2 - Conversion Tool Page
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Figure 3 — Conversion Tool Page with Entered Values
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3.3 Enter Project Information Screen

To start the risk assessment, enter the project information as shown in Figure 4.

Figure 4 — Project Information Page

w» DICE Tool v23143

File GoTo

Enter Project Information
Project Information

Project Name:

<-Select-> v
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] Browse

Project Output Directory:

Inventory Year: [

Meteorological Data

Surface Met Data File (*.SFC) [ | | Browse

} Browse

Profile Met Data Fiee ("PFL): |
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Building Downwash

[ Include Building Downwash

Previous @

Convert

3.3.1 Project Information

In the project information box, input a Project Name as shown in Figure 5. The Project Name
will be displayed on the project’s summary reports.

Figure 5 — Entering the Project Name

w» DICE Tool v23143

File GoTo

Enter Project Information
Project Information

Project Name: |En1er Project Name Here!| ]

Agency Jurisdiction: | <-Select-> v

Project Output Directory: ‘ Browse

Inventory Year:

Select the project’s reviewing agency by using the Agency Jurisdiction drop down box as
shown in Figure 6. This will load that agency’s recommended HARP2 risk settings, which are



then used to perform the HRA. Risk settings are described in more detail in Section 3.6.3 of
this user guide, including a discussion of how to change from the default pre-set risk settings.

Figure 6 — Selecting Agency Jurisdiction from Dropdown Box

w» DICE Tool v23143
File GoTo
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Project Information

Project Name: |Enter Project Name Here!

Agency Jurisdiction:
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To enter a project folder name in the Project Output Directory box, first select the Browse
button indicated by the red arrow in Figure 7. A Browse for Folder window will appear as

shown in Figure 8.

Figure 7 — Selecting the Browse Button
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Figure 8 — Browse for Folder Window
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Navigate through your computer’s files and select the desired location of your output files. To
make a new folder, select the Make New Folder button as indicated by the red arrow in

Figure 9. After selecting the output folder location, click OK to finish.

Figure 9 — Making New Folder Location
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Enter the year in which the engine’s emissions occurred into the Inventory Year box as
indicated by the red arrow in Figure 10. Otherwise, leave this box blank.

Figure 10 — Entering Project’s Inventory Year

w» DICE Tool v23143 - X

Enter Project Information

File GoTo
Project Information

Project Name: |Enter Project Name Here!
Agency Jurisdiction: San Joaquin Valley APCD v

Project Output Directory:  |C:\Users\yeungn\Desktop\DICE Tool Project\DICE Tool Guide Exanl Browse

Inventory Year: 2029 @

3.3.2 Meteorological Data

Next, the meteorological data needed to run the air dispersion model must be loaded into the
tool. These data can be obtained from the local air district or from the California Air Resources
Board (CARB) website at:

https://ww2.arb.ca.gov/resources/documents/harp-aermod-meteorological-files

To enter the meteorological data, click the Browse buttons next to the Surface and Profile Met
Data File boxes as shown in Figure 11 and select the .SFC and .PFL files of the selected
meteorological site.

Figure 11 - Importing the Meteorological Data

Meteorological Data
Suface Met Data Fie (*.SFC): - ]| Browse @
Profile Met Data File (PFL): | | | Browse
Base Elevation (m): ]

Dispersion Coefficients: @ Rural (O Urban

Urban Population:

Next, enter the chosen site’s Base Elevation and select the Dispersion Coefficient type. If the
urban dispersion coefficient is selected, enter the Urban Population of the project’s location.
As an example, in Figure 12, the Fresno Met site was selected and its base elevation of 101.5
meters was entered. The urban dispersion coefficient was selected and the project location’s
population of 549,702 was entered.


https://ww2.arb.ca.gov/resources/documents/harp-aermod-meteorological-files

Figure 12 — Entered Meteorological Data

MELEUVIVIVYIal Uala

Surface Met Data File (*.SFC): \lT:\TOXlC\SCREEN\DATA\Ol Meteorological_Data\AERMET v180 Browse

Profile Met Data File (*.PFL): lT:\TOXIC\SCREEN\DATA\(H Me(eonolog;:al_Data\AERMET v180 Browse

Base Elevation (m): [ 101.5j

Dispersion Coefficients: (O Rural ® Urban

Urban Population: 549702

3.3.3 Building Downwash

If the DICE is located near a building and the exhaust stack is subjected to building downwash,
the user can include building downwash in the air dispersion model by clicking the Include
Building Downwash check box as shown in Figure 13. If the building downwash option is

selected, the user will be prompted later to enter the building information. Click the Next
button to continue to the next step.

Figure 13 - Specifying Building Downwash

Building Downwash

Include Building Downwash

Convert Next




3.4 Enter Engine Information Screen

The Enter Engine Information Screen collects engine emissions and exhaust information as

shown in Figure 14.

Figure 14 — Enter Engine Emissions Data

File GoTo

Enter Engine Information
Engine Data

Engine Horsepower:

Engine Load Factor (%)

Engine Annual Usage hours v
Diesel PM10 Emission Factor: g/bhp+hr v
Diesel PM10 Emissions (b/Ar): | Calculate
Exhaust Stack Parameters
Stack Orientation: | <-Select-> v|
Stack Height (m):
Stack Intemal Diameter (m):
Filin Based | oruse | Lok Up Table
Stack Exhaust Temperature (K):
Stack Exit Velocity (m/s): Calculate
Stack Exit Flow Rate (m"3/s) Calculate
ot Foven

3.4.1 Engine Data

In the Engine Data Section, the user must enter or calculate the Diesel PM10 Emissions. The
user is only required to enter the annual diesel PM10 emissions indicated by the red arrow in
Figure 15.

Figure 15 - Entering Engine Specification Data

& DICE Tool v23143 = X

File GoTo

Enter Engine Information
Engine Data
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Engine Annual Usage
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However, if the user would like the tool to calculate the annual diesel PM10 emission rate, the
user may instead enter the Engine Horsepower, Engine Load Factor, Engine Annual Usage,
and Diesel PM10 Emission Factor and then press the Calculate button to generate the annual
diesel PM10 emission rate as shown in Figure 16.

Figure 16 — Generating Diesel PM10 Emissions from Engine Information

w» DICE Tool v23143
File GoTo

Enter Engine Information

Engine Data
Engine Horsepower: 300}
Engine Load Factor (%): [ 100}
Engine Annual Usage: 100} hours v
Diesel PM10 Emission Factor: 0 01} g/bhphr v
Diesel PM10 Emissions (b/Ar): | 0 66“ mﬂ ¢

The Engine Annual Usage can be entered as hours operated or gallons of diesel fuel consumed.
The Diesel PM10 Emission Factor can be entered as g/bhp-hr or g/kw-hr. To select which unit
to use, click the drop down boxes shown in Figures 17 and 18.

Figure 17 — Selecting Units for Engine Annual Usage

w» DICE Tool v23143
File GoTo

Enter Engine Information

Engine Data
Engine Horsepower: 300:
Engine Load Factor (%): 100.
Engine Annual Usage: 100?
— 8 hours
Diesel PM10 Emission Factor: | 0.01‘ |gallons
Diesel PM10 Emissions (b/yr): 0.66 Calculate
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Figure 18 — Selecting Units for Diesel PM10 Emission Factor

w» DICE Tool v23143 - X

File GoTo

Enter Engine Information

Engine Data
Engine Horsepower: 300:
Engine Load Factor (%): 100:
Engine Annual Usage: 100| hours v

Diesel PM10 Emission Factor: 0 01:
Diesel PM10 Emissions (b/yr): | 0.66| |a/kw-hr

The next step is to enter the exhaust stack parameters. First, select the stack orientation of
the DICE by using the Stack Orientation drop down box as shown in Figure 19. The Stack
Orientation drop down box gives the user three options to select from: vertical, capped, and
horizontal. Vertical and horizontal refer to the direction of exhaust and capped is used when
the exhaust has a fixed rain cap that obstructs the vertical momentum of the exhaust. Flappers
are considered vertical.

Figure 19 — Selecting Stack Orientation

Exhaust Stack Parameters

Sk Orraton

<-Select->
Stack Height (m): Vertical
Capped
Stack Intemal Diameter (m): Horizontal )
.7 F'“;':, ?.‘a;ed oruse Look Up Table

Next, enter the Stack Height (meters), Stack Internal Diameter (meters), Stack Exhaust
Temperature (Kelvin), and Stack Exit Velocity (meters/second) in the boxes shown in Figure 20.
The user also has the option to calculate the Stack Exit Velocity if the Stack Exit Flow Rate is
known by clicking the Calculate button.

Note: In order to use the Stack Exit Velocity (m/s) Calculate button, values must be entered
for the Stack Internal Diameter (m) and the Stack Exit Flow Rate (m3/s). In order to use the
Stack Exit Flow Rate (m3/s) calculate button, values must be entered for the Stack Internal
Diameter (m) and the Stack Exit Velocity (m/s).

12



Figure 20 — Entered Stack Parameter Data

Exhaust Stack Parameters

Stack Orientation: | Vertical v
Stack Height (m): | 3
Stack Intemal Diameter (m): \ 0.13] S
: 3 il Based | oruse | Look Up Table
Stack Exhaust Temperature (K): 789
Stack Exit Velocity (m/s): 57.4| Calculate

Stack Exit Flow Rate (m"3/s): 0.76188 Calculate

If the information for stack parameters is not available to the user, default parameters may be
used instead. In order to use the default parameters, the engine’s horsepower must be known.
Once the engine horsepower has been entered, the user may click the Fill-in Based on HP
button to autofill the exhaust stack parameters, or manually select parameters from the Select
Engine Stack Parameters table. To access this table, shown in Figure 21, click the Look Up
Table button. From the table, the user may select the brake-horsepower (BHP) range
representing the engine, and then either click Select or double-click the row to copy the default
values to the input form’s exhaust stack parameter fields. When all of the fields are complete,
click the Next button to go to the next screen in the DICE Risk Tool.

Figure 21 - Engine Stack Parameters Look-Up Table

Select Engine Stack Parameters :
BHP Range Count BHP (5;“3"" Helght Dace o) ?:)er:puesr(ature f"’l‘ﬁs‘)/e'”"y

» 0-50 59 48 21 0.06 813 471
51-100 616 86 24 0.07 797 56.9
101-150 406 131 24 0.09 755 53
151-175 301 166 24 0.1 795 469
176-200 107 197 29 0.1 761 55.5
201275 413 237 3 01 780 56.4
276-300 21 279 3 0.13 789 57.4
301-400 582 355 3 0.13 780 639
401-500 275 464 31 0.15 770 594
501-600 187 539 34 0.15 786 69.8
601-750 195 680 37 0.2 764 57.8
751-825 313 755 37 0.2 755 55.8
826-1150 310 954 38 0.25 775 535
1151-1500 292 1474 43 0.25 750 522
1501-1850 128 1800 49 03 751 57.4
1851-2500 259 2220 53 0.36 750 51.8
2501-3500 429 2923 6.1 046 747 451
3501-4500 175 3705 76 0.51 753 456
>4500 22 4680 76 0.58 786 40
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3.5 Building Information Screen

If the Include Building Downwash option was checked on the Enter Project Information
screen, the user will be prompted to provide information required for the program to calculate
downwash. In Figure 22, the red circled cross represents the stack, and the numbered grey
boxes represents the different potential building locations relative to the stack. Only one
building may be included in the screening model.

Figure 22 — Building Information Page

DICE Tool v23143

File GoTo

Building Information

1 2 3

Y4 Se 6

7 8 9
X

Building Posttion Relative to Stack: | <-Select->
Buidling Distance to Stack (m):
Building Height (m):
Building X Dimension {m):

Building Y Dimension {m):

Convert Previous Next

To select the building’s relative position, click the Building Position Relative to Stack
dropdown box. From the dropdown box shown in Figure 23, choose a number from 1 to 9 to
match the building’s relative position to the stack. For example, if the building is north of the
stack, the user should select the number 2. Stack position 5 should be used if the stack is
exhausting through the roof of a building.

14



Figure 23 — Selecting Building Relative Position

Building Position Relative to Stack: 2 v
<-Select->
Buidling Distance to Stack (m): 1
Building Height (m): 3
4
Building X Dimension (m): 2
Building Y Dimension (m): é
9

The next step is to enter the desired Building Distance to Stack (m), the Building Height (m),
the Building X Dimension (m) (east-west) and Building Y Dimension (m) (north-south), as
shown in Figure 24. The Building Distance to Stack should be measured from the stack to the
nearest edge of the building. Click Next when finished.

Figure 24 — Entering Building Dimensions

Building Posttion Relative to Stack:
Buidling Distance to Stack (m):
Building Height (m):

Building X Dimension (m):

UL

Building Y Dimension (m):
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3.6 Enter Receptor Information Screen

The Enter Receptor Information screen requires the user to input receptor distances, select
either the default air dispersion modeling grid or custom grid spacing, and customize the risk

settings, as shown in Figure 25.
Figure 25 — Enter Receptor Information Screen

DICE Tool v23143

File GoTo

Enter Receptor Information
Receptor Distances

Resident (m)
Worker (m) L

Receptor Grid
(@ Use Defaut Grid Spacing

(O Use Custom Grid Spacing

Risk Settings

Use District Defaults

Convert

3.6.1 Receptor Distances

The distance to the nearest Resident (m) and Worker (m) must be entered, as shown in

Figure 26. Risk will be calculated at these distances using the exposure assumptions selected
in the next screen in the DICE Risk Tool.

Figure 26 — Entering Receptor Information

File GoTo

Enter Receptor Information
Receptor Distances

Resident (m): L 100
Woter
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3.6.2 Receptor Grid

Selecting the Use Default Grid Spacing setting will calculate the risk results using a telescoping
polar grid with varying receptor spacing from 10 meters out to 4,850 meters from the diesel
engine (located at the grid’s origin point).

Figure 27 — Use Default Grid Spacing

Receptor Grid

(® Use Defautt Grid Spacing

(O Use Custom Grid Spacing

Selecting the Use Custom Grid Spacing setting will calculate the risk results using a polar grid
with up to six receptor rings at the distances specified. These are in addition to the worker
and resident receptor distances previously identified.

In Figure 28, the Use Custom Grid Spacing setting was selected and values were entered into
the boxes Distance 1 through Distance 6. The user has the option to use up to six receptor ring
distances by checking or unchecking the Distance number boxes. Compared to the Use Default
Grid Spacing setting, a custom grid allows the user to decrease the number of receptors used
in the risk assessment.

Figure 28 — Use Custom Grid Spacing Selected and Distances Entered
Receptor Grid
(O Use Default Grid Spacing

(® Use Custom Grid Spacing

Distances (m)

Distance 1 50| Distance 2 75! Distance 3
Distance 4 150 Distance 5 250] Distance 6 | 500

3.6.3 Risk Settings

As shown in Figure 29, the Use District Defaults risk settings box is automatically checked. The
default risk settings are determined the agency selected in Section 3.3.1 of this user guide.

17



Figure 29 - Using District Defaults Risk Setting

Risk Settings

Use District Defaults

In order to edit the risk settings, the user must uncheck the Use District Defaults box and click
the View/Edit Settings button to open the Risk Settings window, shown in Figure 29.

Note: It is recommended that the user consult with the project’s reviewing agency before
making any changes to the default risk settings.

The risk settings shown in Figure 30 are the default options used by the San Joaquin Valley Air
Pollution Control District (SJVAPCD); however, the risk settings will change depending on the
agency that was selected.

Figure 30 — Risk Setting Page with San Joaquin Valley Air Pollution Control District Risk

Settings
w» DICE Tool v23143 —_ X
File GoTo
A
Risk Settings Reset
Flagpole Receptor Height (m): [ 0
Parameter Resident Receptors Worker Receptors
Exposure Duration (years) [70 ~ [40 «
Intake Rate Percentie OEHHA Derived vl OEHHA Derived v
Time Away From Home <16 Years Old: O
Time Away From Home =>16 Years Old: O
O
Moderate Intensity (Recommended)
O

Moderate Intensity (Recommended)

Note: The starting ages for the resident and worker are 3rd timester and 16 years old, respectively. These cannot be changed in this tool.

Close

If the user wants to perform a refined analysis, they may edit the values in the Risk Settings
window. The user may assign a Flagpole Receptor Height (m), change the Exposure Duration
(years) for the resident and worker receptors, apply Time Away from Home <16 Years Old or
Time Away from Home =>16 Years OIld factors to the resident receptors, or Use 8-hour
Breathing Rates for Resident and/or Worker Receptors.

18



3.7

The user should consult with the reviewing agency before changing these values. For a
technical understanding of these inputs, please refer to the HARP2 User Guide® and the OEHHA
Health Risk Assessment Guidelines?.

To restore the risk settings to the selected agency’s district defaults, click the Reset button on
the top of the Risk Settings page shown in Figure 30.

Run and View Results Screen

After all user inputs are entered, the final step of the DICE Risk Tool generates the risk
screening results. Figure 31 shows the Run and View Results screen where the air dispersion
modeling is performed and the health risk is calculated.

! California Air Resources Board. 2015. User Manual for the Hotspots Analysis and Reporting Program
Air Dispersion Modeling and Risk Assessment Tool Version 2. Available online at:
https://ww2.arb.ca.gov/resources/documents/harp-air-dispersion-modeling-and-risk-tool.

2 Office of Environmental Health Hazard Assessment. 2015. Air Toxics Hot Spots Program Risk
Assessment Guidelines: Guidance Manual for Preparation of Health Risk Assessments. Available online
at: https://oehha.ca.gov/air/crnr/notice-adoption-air-toxics-hot-spots-program-guidance-manual-
preparation-health-risk-0.
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Figure 31 - Run and View Results Page

w» DICE Tool v23143 = X
File GoTo

Run and View Results

Run Step 1. Calculate ground level pollutant concentration

Status: Not completed

Run Step 2. Calculate health risk

Status: Not completed

View Step 3. View screening risk results

Fodon

Click the Run button next to Step 1. Calculate ground level pollutant concentration as shown
in Figure 32.

Figure 32 - Calculating Ground Level Pollutant Concentration

Step 1. Calculate ground level pollutant concentration

Status: Completed
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A new window will appear, as shown in Figure 33, tracking the progress of the air dispersion
model’s calculation of the ground level pollutant concentrations. Once the model is finished,
the status under Step 1 will change to Completed.

Figure 33 - Ground Level Pollutant Concentration Being Calculated

® ' C:\DICE\AERMOD.exe — o X

After the ground level pollutant concentrations have been calculated, a message box asking
the user if they would like to calculate the health risks will appear, as shown in Figure 34. Select
Yes to continue with the health risk calculations and another progress window will appear
similar to that shown in Figure 33.

Figure 34 - Calculating Health Risk Scores

GLCs have been calculated.
Would you like to calculate health risks now (Step 2)7

Yes No

The user may also initiate the health risk calculations by clicking the Run button next to Step
2. Calculate health risk as shown in Figure 35. Once the health risk calculation is finished, the
status under Step 2 will change to Completed.
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Figure 35 - Calculating Health Risk Scores

Run Step 2. Calculate health risk

Status: Completed

Once the health risk calculations are finished, a report will open in the user’s web browser. An
example report is shown in Figure 36.

In order to view the most recent HRA report created by the DICE Risk Tool after closing out the
report, click the View button next to Step 3. View screening risk results as shown in Figure 37.

Note: The HRA report is saved as a HTML file in the project folder. This type of file may be
viewed in a web browser or word processing program. Word processing programs can convert
the HTML HRA report to other types of files.
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Figure 36 — DICE Risk Tool Results Report

Non-Vehicular Diesel Engine Risk Screening Tool Results

Table 1. Results Summary

Cancer Chronic Acute
R t
Receptor Risk Receptor Hazard Index Receptor Hazard D?;e;;r
(in a million) Distance (m) {HI) Distance {m}) Index (HI) (m)
Resident
0.5 100 0 100 - -
(MEIR)
Worker (MEIW) 0.1 25 0 5 - -
Maximum
(P) 0.8 50 0 50 - -
Table 2. Inputs

Project Information

Project Name:

Enter Project Name Here!

Agency Jurisdiction:

San Joaquin Valley APCD

Project Qutput Directory:

C:\Users\yeungn\Desktop\DICE Tool ProjectyDICE Tool Guide Example\DICE
Tool Example Project

Date Assessment Conducted:

9/7/2023 8:50:01 AM

Inventory Year:

2023

Tool Version:

23143

Meteorological Data

Surface Met Data File {(*.SFC):

TATOXIC\SCREEN\DATA\O1 Meteorological_Data\AERMET
v1B081_UStaryFresno_93193\Fresno_2013-2017.5FC

Profile Met Data File {(* PFL):

TATOXIC\SCREEN\DATANO1 Meteorological_Data\AERMET
v18081_UStaryFresno_93193\Fresno_2013-2017 PFL

Base Elevation (m):

1015

Dispersion Coefficients:

Urban

Building Downwash:

Yes | **Building Information** | Rel. Position from Stack: 2 | Distance from
Stack (m): 50 | Bldg Hgt {m): 25 | Bldg X Dim (m}): 50 | Bldg ¥ Dim (m): 50

Engine Information

Engine Horsepower: 300
Engine Load Factor (%): 100
Engine Annual Usage: 100 haurs
Diesel PM10 Emission Factor: 0.01 g/Bhp-hr
Diesel PM10 Emissions (1bfyr): 0.66
Stack Height (m): 3
Stack Diameter (m): 013
Stack Temperature (K): 789
Stack Exit Velocity (m/s): 574
Risk Settings
Use District Defaults: Yas
Flagpole Receptor Height (m): a
Deposition Rate (g/s): NA

Receptor Type: Resident Worker
Exposure Duration {yrs): 70 40
Intake Rate Percentile: QEHHA Derived OEHHA Derived
Time Away from Home <162 No -

Time Away from Home =>16: Mo -

Use 8-Hour Breathing Rate: No No
Enabled Pathways: Inhalation Only Inhalation Only

Table 3. DPM Concentration and Risk by Receptor Distance

Receptor OPM . Resident : Worker

Distance | Concentration | C3NC2T Risk . Acute | Cancer Risk i Acute
(m) (ug/m?) {|n a Chronic HI i |:.|'1_a Chronic HI a

million) million)

50 0.0007826806 0.8 0 - 01 0 -
75 0.0006100829 0.6 [ - 0.1 0 -
100 0.0004612601 0.5 o - 0l 0 -
150 0.0002897588 0.3 0 - 0 0 -
250 0.0001513462 0.2 0 - 0 0 -
500 5.861246E-05 0.1 o - 0 0 -
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Figure 37 - Viewing the Screening Risk Results

View Step 3. View screening risk results

3.8 DICE Risk Tool Results Report

The DICE Risk Tool’s results report is divided into three tables: Results Summary, Inputs, and
DPM Concentration and Risk by Receptor Distance. The information provided in each table is
presented below.

3.8.1 Table 1. Results Summary

Figure 38 presents a summary of the results for the project. This table contains the maximally
exposed individual resident and worker (MEIR and MEIW) cancer risk and chronic hazard index
(HI) at the distances specified by the user. The Maximum (PMI) is the point of maximum
impact, and the cancer risk presented uses residential exposure assumptions. The Maximum
(PMI) provides the project’s maximum calculated cancer risk and chronic HI and is dependent
on the receptor grid spacing. Inthe example below, the Maximally Exposed Individual Resident
cancer risk is 0.5 in a million (5 x 107) at a distance of 100 meters. The acute hazard index
values are not populated, as the state has not published acute non-cancer risk factors for diesel
particulate matter.

Figure 38 — Results Summary Table

Table 1. Results Summary
Cancer Chronic Acute
R it
Receptor Risk Receptor Hazard Index Receptor Hazard DEi;faifer
(in a million) Distance (m) {H1) Distance (m) Index (HI) (m)
Resident
0.5 100 0 100
(MEIR)
Worker (MEIW) 0.1 25 0 25
Maximum
0.8 50 0 50
(PMI)
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3.8.2 Table 2. Inputs

Figure 39 summarizes all user inputs to the DICE Risk Tool. This table allows reviewing agencies
to view the meteorological data, dispersion coefficient, building information, engine
information, and risk settings used in the project without having to open the DICE Risk Tool.

Figure 39 — Project Input Information Table

Table 2. Inputs

Project Information

Project Name:

Enter Project Name Here!

Agency Jurisdiction:

San Joaquin Valley APCD

Project Output Directory:

CAUsers\yeungnDesktop\DICE Tool Project\DICE Tool Guide Example\DICE

Tool Example Project

Date Assessment Conducted:

9/7/2023 8:50:01 AM

Inventory Year:

2023

Tool Version:

23143

Meteorological Data

Surface Met Data File (*.5FC):

TATOXIC\SCREEN\DATA\D1 Meteorclogical_Data\AERMET
v18081_UStar\Fresno_93193\Fresno_2013-2017.5FC

Profile Met Data File (*.PFL):

T\TOXIC\SCREEN\DATA\01 Meteorological_Data\AERMET
v18081_UStar\Fresno_93193\Fresno_2013-2017.PFL

Base Elevation (m):

1015

Dispersion Coefficients:

Urban

Building Downwash:

Yes | **Building Information** | Rel. Position from Stack: 2 | Distance from
stack (m): 50 | Bldg Hgt (m): 25 | Bldg X Dim (m): 50 | Bldg ¥ Dim (m): 50

Engine Information

Engine Horsepower: 300
Engine Load Factor (%): 100
Engine Annual Usage: 100 hours
Diesel PM10 Emission Factor: 0.01 g/bhp-hr
Diesel PM10 Emissions (1bfyr): 0.66
Stack Height (m): 3
Stack Diameter {m): 0.13
Stack Temperature (K): 789
Stack Exit Velocity (m/s): 574
Risk Settings
Use District Defaults: Ves
Flagpole Receptor Height (m): 0
Deposition Rate (g/s): NA

Receptor Type: Resident Worker
Exposure Duration (yrs): 70 40
Intake Rate Percentile: OEHHA Derived OEHHA Derived
Time Away from Home <16: No -

Time Away from Home =>16: No -

Use &-Hour Breathing Rate: No Mo

Enabled Pathways:

Inhalation Only

Inhalation Only
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3.8.3 Table 3. DPM Concentration and Risk by Receptor Distance

Figure 40 presents the diesel particulate matter (DPM) concentration as well as the cancer risk
and chronic HI results for residents and workers at each ring distance in the receptor grid. In
the example below, the results were calculated for six user specified distances using the Use
Custom Grid Spacing option (see Section 3.6.2 of this user guide). If the Use Default Grid
Spacing option were selected, Table 3 would have generated results at 60 discrete distances

from 10 meters to 4,850 meters.

Figure 40 — Receptor Grid DPM Concentration and Risk Score Table

Table 3. DPM Concentration and Risk by Receptor Distance
Receptor oPM Cancer Risk — Cancer Risk o
Distance | Concentration - i Acute - i Acute
(m) (ug/m?) {|n a Chranic HI " |:.|j 3 Chronic HI al
million) million)
50 0.0007826806 0.8 0 0.1 0
75 0.0006100829 0.6 0 0.1 0
100 0.0004612601 05 0 01 0
150 0.0002897588 03 0 0 0
250 0.0001513462 0.2 0 0 0
500 5.861246E-05 0.1 0 0 0
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4. Output Files
4.1 DICE Risk Tool Output File Summary

After the user calculates the ground level pollution concentrations and health risk results, the
DICE Risk Tool will generate AERMOD and HARP files into the Project Output Directory folder
location. Table 1 summarizes these output files.

Table 1. DICE Risk Tool Output File Summary

File Name

File Description

DICE Tool Files

ProjectName.dice

DICE Risk Tool project file containing all project
inputs. Replace ‘ProjectName’ with the Project Name
entry from Enter Project Information page.

Air Dispersion Modeling Files

AERMOD.inp AERMOD input file
AERMOD.out AERMOD output file
. Building Profile Input Program (BPIP) input file (only
BPIP.inp - .
created when building downwash option is used)
Building Profile Input Program (BPIP) output file (only
BPIP.out - .
created when building downwash option is used)
Building Profile Input Program (BPIP) summary file
BPIP.sum (only created when building downwash option is
used)
STKO1.PLT AERMOD period plot file for the project engine

Risk Assessment Files

9901AnnualConc.txt

Diesel Particulate Matter (DPM) ground level
concentration (GLC) file for use with HARP2

Res1CancerRisk.csv

HARP2 residential cancer risk output file. Contains
detailed cancer risk results by receptor and pollutant.

Res1CancerRiskSumByRec.csv

HARP2 residential cancer risk output file. Contains
summed cancer risk results by receptor for all
sources and pollutants.

Res1Output.txt

HARP2 residential cancer risk output file. Contains a
summary of settings used in HARP2 analysis.

Res2NCChronicRisk.csv

HARP2 residential chronic non-cancer risk output
file. Contains detailed chronic Hl results by receptor,
pollutant, and affected pathways.

Res2NCChronicRiskSumByRec.csv

HARP2 residential chronic non-cancer risk output
file. Contains summed chronic Hl results by receptor
for all sources, pollutants, and affected pathways.

Res20utput.txt

HARP2 residential chronic non-cancer risk output
file. Contains a summary of settings used in HARP2
analysis.
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File Name

File Description

ResCancerHRAInput.hra

HARP2 input file. Contains all inputs for use in
performing residential cancer risk analysis using
HARP2.

ResChronicHRAInput.hra

HARP2 input file. Contains all inputs for use in
performing residential chronic non-cancer risk
analysis using HARP2.

Worker1CancerRisk.csv

HARP2 worker cancer risk output file. Contains
detailed cancer risk results by receptor and pollutant.

WorkerlCancerRiskSumByRec.csv

HARP2 worker cancer risk output file. Contains
summed cancer risk results by receptor for all
sources and pollutants.

Workerl1Output.txt

HARP2 worker cancer risk output file. Contains a
summary of settings used in HARP2 analysis.

Worker2NCChronicRisk.csv

HARP2 worker chronic non-cancer risk output file.
Contains detailed chronic HI results by receptor,
pollutant, and affected pathways.

Worker2NCChronicRiskSumByRec.csv

HARP2 worker chronic non-cancer risk output file.
Contains summed chronic HI results by receptor for
all sources, pollutants, and affected pathways.

Worker20Qutput.txt

HARP2 worker chronic non-cancer risk output file.
Contains a summary of settings used in HARP2
analysis.

WorkerCancerHRAInput.hra

HARP2 input file. Contains all inputs for use in
performing worker cancer risk analysis using HARP2.

WorkerChronicHRAInput.hra

HARP2 input file. Contains all inputs for use in
performing worker chronic non-cancer risk analysis
using HARP2.

Risk Results Report

DICESummaryReport.htm

Summarizes results from DICE Risk Tool. Provides
detailed information of inputs used in the tool as well
as cancer risk and chronic HI for maximally exposed
resident (MEIR), maximally exposed worker (MEIW),
and point of maximum impact (PMI).
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